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1 Welcome
Welcome to PicoDiagnostics, the automotive fault-finding software for your
PicoScope Oscilloscope.

With a PicoScope, PicoDiagnostics turns your PC into an automotive diagnostics tool.
The program includes a range of built-in tests that are easy to operate, even if you
haven't used them before.

If you need to go beyond the built-in tests, an additional program is available: 
PicoScope Automotive. This software will have been downloaded and installed along
with PicoDiagnostics. This gives you all the features of an advanced oscilloscope and
can be used to diagnose almost any electrical component in any vehicle.

http://www.picoauto.com/software.html
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2 Introduction
PicoDiagnostics supports the PicoScope 3000 Automotive and 4000 Automotive
Series diagnostic oscilloscopes.

How to use PicoDiagnostics
Getting started: see Using PicoDiagnostics for the first time. 
For further information: see descriptions of Menus.

2.1 Contact information
Address: Pico Technology

James House
Colmworth Business Park
ST NEOTS
Cambridgeshire
PE19 8YP
United Kingdom

Web site: www.picoauto.com

2.2 System requirements
PicoDiagnostics software: runs on a PC or laptop running a Windows XP SP3,
Windows Vista, Windows 7, or Windows 8 operating system. Processes data from the
PicoScope oscilloscope and displays the results in various graphical formats.

2.3 Using PicoDiagnostics for the first time
We have designed PicoDiagnostics to be as easy as possible to use, even for
newcomers to automotive diagnostics.  Once you have followed the introductory steps
listed below, we hope that you will soon become an expert.

1. 

Plug in your PicoScope oscilloscope.  Windows will recognise it
and make the necessary changes to allow your computer to
work with it.  Wait until Windows tells you that the device is
ready to use. 

2. Click the new PicoDiagnostics icon on your Windows desktop. 

3. Click the button for the test you wish to perform.

4. 
Follow the on-screen Setup Wizards or instructions on
connecting your scope and running the test.
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2.4 Licence agreement
The material contained in this release is licensed, not sold. Pico Technology grants a
licence to the person who installs this software, subject to the conditions listed below.

Access. The licensee agrees to allow access to this software only to persons who have
been informed of these conditions and agree to abide by them.

Usage. The software in this release is for use only with Pico products or with data
collected using Pico products.

Copyright. Pico Technology claims the copyright of, and retains the rights to, all
material (software, documents etc.) contained in this release. You may copy and
distribute the entire release in its original state, but must not copy individual items
within the release other than for backup purposes.

Liability. Pico Technology and its agents shall not be liable for any loss, damage or
injury, howsoever caused, related to the use of Pico Technology equipment or
software, unless excluded by statute.

Fitness for purpose. No two applications are the same: Pico Technology cannot
guarantee that its equipment or software is suitable for a given application. It is your
responsibility, therefore, to ensure that the product is suitable for your application.

Mission-critical applications. This software is intended for use on a computer that
may be running other software products. For this reason, one of the conditions of the
licence is that it excludes usage in mission-critical applications, for example life-
support systems.

Viruses. This software was continuously monitored for viruses during production, but
you are responsible for virus-checking the software once it is installed.

Support. If you are dissatisfied with the performance of this software, please contact
our technical support staff, who will try to fix the problem within a reasonable time. If
you are still dissatisfied, please return the product and software to your supplier within
14 days of purchase for a full refund.

Upgrades. We provide upgrades, free of charge, from our web site at
www.picotech.com. We reserve the right to charge for updates or replacements sent
out on physical media.

Trademarks. Windows is a registered trademark of Microsoft Corporation. Pico
Technology and PicoScope are internationally registered trade marks.

http://www.picotech.com
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3 Menus
Menus are the quickest way to get to the main features in PicoDiagnostics.  The
Menu bar is always present at the top of the PicoDiagnostics main window, just
below the window's title bar. You can click any of the menu items, or press the Alt key
and then navigate to the menu using the cursor keys, or press the Alt key followed by
the underlined letter in one of the menu items. 

The list of items in the menu bar may vary depending on which test you are running.

3.1 File menu
Click File on the Menu bar.

Load.  Allows you to load a test from disk to review the result.  Loading a test
result from disk will clear any captured data and results.

Save.  Some tests allow you to save test data to disk.

Print. Opens a standard Windows print dialog, which allows you to choose a
printer, set printing options and then print the selected view.

Print Preview. Opens the Print Preview window, which allows you to
preview the report before printing it with the Print command.

Preferences. Opens up the User Details dialog.

Exit. Close PicoDiagnostics without saving any data.
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3.1.1 User Details dialog
This dialog appears when you select Preferences on the File menu.  It allows you to
enter details about your company and your name. These will appear on the report.

How to use the dialog
Enter all the values you want.

Click OK to close the dialog and save the changes.

Click Cancel to close the dialog and discard the changes.

The items in the dialog

Company: The name of your company. This will be displayed on the report if no
logo has been selected.

Name: Name of the technician, or the contact name, to appear on the
report.

Telephone: The contact number that the customer will see on the report.

Address: The address of your company. There is space for four lines.

Logo: Your company logo (selecting a file here will enable it to appear on
your reports).

3.2 View menu
Click View on the Menu bar.

Details. Edit the customer and vehicle details and notes.
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3.2.1 Customer details dialog
This dialog appears when you select Details on the View menu.  It allows you to enter
details about the customer and the vehicle you are testing. There is also a space for
entering notes about the test.

How to use the dialog
This dialog is for you to store data about the customer and the vehicle that the test
applies to. The data in this dialog will be saved with the test and printed on the report.

Click OK to close the dialog and save the changes.

Click Cancel to close the dialog and discard the changes.
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Customer details

Name. The customer's name.

Phone. The customer's phone number.

Address. The customer's address. There is space for 4 lines.

Vehicle details

Make. The make of the vehicle. The makes of vehicles are stored in a database. If you
manually enter a make which is not already saved, a message box will pop up.

Model. The model of the vehicle. When a make has been selected, this list is
populated with all the currently known models of that make.

Year. The year of the vehicle.

ID. An identification number for the vehicle. Can be the VIN or anything else you
choose.

Notes

In the Notes field you can enter additional information that you want stored with the
test.
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3.3 Tests menu
Click Tests on the Menu bar.

This menu lists all the tests available.  Click one of the tests to proceed.

3.4 Options menu
The Options menu changes depending upon which test you are carrying out at the
time. Please see below for links to the test options you require:

Cylinder balance options

Compression test options

Battery test options

NVH test options

Propshaft balancing options

3.5 Help menu
Click Help on the Menu bar.

These are the standard Windows options for access to this help file.

Note: Show Vibrate Help option only appears when within the NVH test.



PicoDiagnostics User's Guide 9

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved. pd.en r12

4 Tests
PicoDiagnostics is a collection of specific automotive tests.  They are all designed to
be easy to use, even if you have little or no experience of automotive diagnostics.

To begin any test, click the PicoDiagnostics icon on your computer:

These tests are available with this installation of PicoDiagnostics:

Cylinder Balance

Compression Test

Battery Test

NVH

Propshaft Balancing

4.1 Cylinder balance
4.1.1 Introduction

The cylinder balance test measures how much each cylinder contributes to the
engine's total power output.  There are a number of things that can cause a cylinder to
contribute less than the other cylinders.  These include but are not limited to:

low compression
faulty injector
faulty spark plug.

A slightly uneven balance does not necessarily mean that there is a fault in the engine.
During warm-up, most engines run slightly unevenly. Deposits and engine wear may
also have an effect on the engine's performance.  

To use the cylinder balance, start PicoDiagnostics and set the test conditions.

4.1.2 Test conditions
The following test conditions must be met before running the test:

The engine must be at normal running temperature. This can be confirmed when
the cooling fan has activated twice, and by referencing the temperature gauge on
the vehicle's dashboard.
The engine must be off before connecting the oscilloscope.

If this is the first cylinder balance test you are running, load the test using the Tests
menu. Follow the on-screen wizard instructions to connect your PicoScope to the
vehicle. If however you have already run a cylinder balance test, simply click Setup
and follow the on-screen wizard instructions.



Tests10

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved.pd.en r12

4.1.3 Wizard
The cylinder balance setup wizard consists of 3 screens. These screens are shown
below:

Screen one

This screen gives guidance on connecting the 
PicoScope ready for the Cylinder Balance test

Connect the oscilloscope

Connect the scope to a free USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your oscilloscope. On the
other end, connect a large red crocodile clip to the red cable and a large black
crocodile clip to the black cable. Connect the red clip to the battery positive (+) and
the black clip to the battery negative (-) as shown in the picture above.
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Screen two

On screen two, identify the number of 
cylinders the vehicle to be tested has

Screen three

This screen shows the signal strength between
 the PicoScope and the vehicle to be tested.

Note: If the signal strength is low you can improve it by switching on various
ancillaries such as mainbeam lights, fog lights, interior fan (full), rear demister.



Tests12

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved.pd.en r12

4.1.4 Options
This dialog appears when you click the Options... menu on the main Menu bar while
the Cylinder Balance Test is selected.  It allows you to set whether the Cylinder
balance wizard appears before running the test.

     

4.1.5 Running the test
To start the test click Start. If the test successfully starts, a new window with a
progress indicator will briefly appear on the screen. The data is now being analysed
and shown in real time on screen with the results appearing in the bar graph as shown
below.

The result
If the test could not produce a result see: Failed cylinder balance.

You can stop the test at any time by simply clicking Stop. It is possible to then scan
through the results by clicking Play. The results are always scaled to show the highest
cylinder at 100%.

Controls
During the test you can right-click on the bar graph to get a control menu.  See: 
Cylinder balance controls.
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4.1.6 Controls
Right-click the cylinder balance bar graph to bring up a menu with display options. You
can use this menu to access more information concerning the test and its result.

Variation
Displays the variation in contribution for
each cylinder as an overlaid blue bar.

Misfire
Displays suspected misfires as a separate
bar for each cylinder.

Signal
Not required for basic testing

Brings up a second graph, the signal
graph, that can display the engine speed
or the contribution for each cylinder over
time. To zoom in on the data, click and
drag to select the range to display.



Tests14

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved.pd.en r12

4.1.7 Signal graph
The signal graph displays the captured data as engine speed or cylinder contribution.

Zooming
You can use the mouse to zoom in on the data. Use the context menu (right-click) to
zoom out again.

Signal graph context menu
Right-click the graph to bring up a menu with display options. You can use this menu
to access more information concerning the test and its result.

Zoom out
This zooms out to display the full dataset.

View
You can choose to view the engine speed or the cylinder contribution.
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4.1.8 Failed test
If the test could not produce a result, make sure that:

the connection to the battery is good
the tension of the alternator belt is adequate.

It may also help if you you switch the headlights on full beam and switch on
other electrical loads, such as the rear windscreen heater and fog lights.

There are some engines for which the test has difficulties producing a result.
These include:

engines with more than 8 cylinders
some engines with dual mass flywheels
engines with inertial dampers
vehicles with xenon lights

If there is still a problem
If you have checked the points mentioned above and the software still cannot
produce a result, we would like you to send us a copy of the of the failed test
data. Please enter as much information as possible about the vehicle tested. This
is done via the Details dialog. Save the test to a file using the File > Save menu
and email the file to us on picodiagnostics.feedback@picotech.com.

mailto:<%LINKCAPTION%>
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4.2 Compression test
4.2.1 Introduction

The compression test is meant to be a first check.  If the compression looks good, you
can quickly move on and investigate other components which might be the cause of
the fault.  If the test detects a low cylinder, you should perform a manual compression
test to verify the results and to work out which cylinder is low.

To use the compression test, start PicoDiagnostics and click Compression Test. 

 Compression test - before starting the test

There are two types of compression test:

Relative compression - requires no pressure transducer, only a connection to the
battery. 
Absolute compression - requires a connection to the battery and a pressure
transducer connected to a spark plug port. 

Follow the instructions below to connect your PicoScope to the vehicle and run the
test.

Set the test conditions
Connect the oscilloscope
Connect the pressure transducer (only for the absolute compression test)
Disable the engine
Run the test
If the result is blank

4.2.2 Test conditions
The following test conditions must be met before running the test:

The engine must be at normal running temperature, which is indicated by the
cooling fan switching on.
The engine must be off before connecting the oscilloscope.
The cranking speed must be normal (battery must be charged).
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4.2.3 Connections
Connecting the oscilloscope
Connect the oscilloscope to a free USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your scope.  On the other
end, connect a large red crocodile clip to the red lead and a large black crocodile clip
to the black lead.  Connect the red clip to the battery positive (+) and the black clip to
the battery negative (—) as shown in the picture below.

Connecting the pressure transducer (absolute compression test only)
Remove the spark plug from any convenient cylinder.  Fit a compression hose into the
empty spark plug socket, then attach it to the pressure transducer's inlet port, as
shown in the picture below.  Then connect a BNC to BNC cable from the pressure
transducer to Channel B on your scope.  

Disabling the engine
The compression test can only be performed when the engine is cranking, so it must
be prevented from starting. This can be done by removing the engine management
relay from the fuse box or disabling the injectors.
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4.2.4 Test setup
The compression test should be performed according to the vehicle manufacturer's
specification.

If you are using the pressure transducer, click Pressure.
Next, click the numbered button corresponding to the number of cylinders in the
engine.

4.2.5 Options
This dialog appears when you click either the Options... menu on the main menu bar
while the Compression Test is selected, or the Pressure button, located at the
bottom of the screen.  It allows you to set special options before running the test. 
These options apply only to the absolute compression test, and not to the relative
compression test.

Compensate: Check to use the Cylinder Volume, Compression Ratio
and Sensor Volume parameters.  Leave unchecked to
ignore these values.

Cylinder Volume (l): The volume of the cylinder in litres.

Compression Ratio (X:1): The compression ratio of the cylinder.  For example, if
the compression ratio is 11:1, enter 11.

Sensor Volume (l): The volume of the pressure sensor in litres.  This
information should be available from the manufacturer
of the sensor.  If in doubt, do not alter the value in this
box.

Engine Capacity: The size in CC of the engine under test.

Use Pressure Sensor: Indicates whether a WPS500X pressure transducer is
being used during the test.

4.2.6 Running the test
To start the test, click Start. 
A new window with a progress indicator and instructions will appear on the screen. 
Wait until the message in the window is "Crank engine".  
With the throttle wide open (accelerator pedal fully pressed), crank the engine until
the progress indicator reaches 100%.  
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The data is now analysed and the result appears in a bar graph, as in one of the
examples below:

Compression test result -
without pressure sensor

(relative mode)

In relative compression mode, the result
is always scaled to show the highest
cylinder at 100%.  The bars are ordered
according to the engine's firing order. The
cylinders are named A, B, C and so on,
because with only a connection to the
battery the software has no way of
knowing which cylinder is number one. 
This may cause the result to be shifted if
you run the test on the same engine
more than once.

Compression test result -
with pressure sensor

(absolute mode)

In absolute compression mode,
PicoDiagnostics shows the true
compression in each cylinder. As in
relative compression mode, the bars are
named A, B, C and so on.

The result
If the test could not produce a result, see Failed compression test.
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4.2.7 Failed test
If the test could not produce a result, make sure that:

the connection to the battery is good
there is not a battery charger connected to the vehicle's electrical system.

If there is still a problem 
If you have checked the points mentioned above and the software still can't
produce a result, we would like you to send us a copy of the of the failed test
data. Please enter as much information as possible about the vehicle tested.
This is done using the Details dialog. Save the test to a file using the File | Save
menu and email the file to us at support@picotech.com.

mailto:support@picotech.com
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4.3 Battery test
4.3.1 Introduction

To use the battery test, start PicoDiagnostics and click Battery Test.  

Tip: If the battery has been recently charged, there is a risk of “surface charge”
affecting the state-of-charge results.  To eliminate the surface charge, switch the
lights on full beam for about 2 minutes and then wait for about 2 minutes before
performing the test.  If you are only measuring cold cranking amps then you can
ignore this precaution.

Follow the instructions below to connect your PicoScope to the vehicle and run the
test.

Connect the PicoScope
Set any special test options
Run the test
If the result is blank
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4.3.2 Connections
Connect the PicoScope
Connect the PicoScope to a free USB port on your PC using the USB cable.

Channel A: Battery voltage
Connect one of the general test BNC cables to Channel A on your PicoScope. On the
other end, connect a large red crocodile clip to the red lead and a large black crocodile
clip to the black lead.  Connect the red clip to the battery positive either on the battery
or in the fuse box. Connect the black clip to a secure earth (ground) point as shown in
the picture below.

Channel B: Starter motor current
Connect the 600 A or 2000 A current clamp to Channel B on the PicoScope. Place the
current clamp (600 amp clamp for light vehicle applications or 2000 amp clamp for
heavy duty applications) so that it is positioned around the positive cables which are
connected to the positive battery terminal. More importantly make sure the current
clamp is positioned around the starter motor positive or negative cable in order to
record the cranking current from the starter.

If you have a 4-channel scope then you can run the optional extended drop test.

Additional connections for extended drop test

In addition to connecting channels A and B as described above, channels C and D must
also be connected as follows:

Channel C: Starter motor positive terminal
Using a BNC to 4 mm lead, connect the red 4 mm plug to the positive terminal of the
starter motor using the appropriate clip / connector. This is the terminal that the main
positive cable from the battery connects to.

Channel D: Starter motor negative terminal
Using a BNC to 4 mm lead, connect the red 4 mm plug to the negative terminal of the
starter motor using the appropriate clip / connector. 

Note: Most modern vehicles don’t have earth cables to the starter motor. In this case
connect to one of the mounting bolts by which the starter motor is attached to the
engine or gearbox bell housing, as the starter will earth through to chassis and/or
battery.

This will enable PicoDiagnostics to separate the cable resistance from the starter
motor resistance.

All connections must be clean and free from oil, grease and dirt to ensure the readings
are accurate.



PicoDiagnostics User's Guide 23

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved. pd.en r12

4.3.3 Setup
First, click either 12 V or 24 V depending on the voltage of your electrical system.

Tip: If you have a 24 V system with two 12 V batteries, test each battery separately.
 Otherwise one good battery could hide a fault in the other battery.

Next, set the Type of battery to match the battery you wish to test.

Set the Temperature to the local air temperature in °C or °F depending on
preferences.

The battery capacity in cold cranking amperes (CCA) should now be entered, along
with its standard (CCA Unit). 

Now, set the battery test options (see Battery test options).
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4.3.4 Options
This dialog appears when you click the Options... menu on the main menu bar while
the Battery Test is selected. Here you can:

Enable the Extended drop test options
Adjust the capture time of the test

Click OK to confirm
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4.3.5 Running the test
Click Start.

Note: Because the engine is not drawing any current at this stage, the program will
draw a horizontal line showing zero amps of current.  If this line is not at zero
amps, the current clamp may need to be adjusted.  Press the "Zero" button or turn
the "Zero" dial on the clamp until the horizontal line is at zero amps.

Start the engine.

While the test is running, the program shows the voltage on Channel A and the
current on Channel B, and a graph is drawn from left to right.  The program
automatically stops recording data when it has enough information, so there is no
need to click the Stop button unless you wish to stop the test early.

The program then analyses the data and shows the results in a table, as in the picture
below:

If the program reports "Battery has failed the test - refer to help file for advice", see 
Interpreting the Results.



Tests26

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved.pd.en r12

4.3.6 Interpreting the results
If the state of charge is low then recharge the battery and re-test.

If the state of charge is all right but the CCA (cold cranking amps) is low then check
these things before replacing the battery:

Check the battery connections.  If they are loose, they could increase the internal
resistance.

If the battery is not a sealed type, check the fluid levels in each cell.
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4.4 Propshaft balancing
The propshaft needs to be balanced after removing one or more components of the
transmission system.  This is done using the PicoDiagnostics Propshaft Balancing
program, by fitting balancing weights on the differential coupling flange, using off-the-
shelf hose clamps on the propshaft, or attaching a single balancing weight to the
propshaft.

4.4.1 Preparing the vehicle
Raise and support the vehicle according to manufacturer directions. Remove the two
rear wheels and secure the rotors or drums to the hub assembly. Position the vehicle
on mounts in order to hold the vehicle level and at the same height as if the wheels
were fitted.

Remove any balancing weights from the flange stud bolts before starting the balancing
procedure.

4.4.2 Running PicoDiagnostics
The propshaft balancing procedure is divided into four stages:

Initial Run
Calibration Runs
Verification
Free run

Click  Balancing:

Click which format you would like to use to complete the propshaft balancing test. 

The program displays step-by-step instructions in the form of a Wizard for both
formats of this test. We recommend that you follow your chosen format procedure
carefully.
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4.4.2.1 Pinion Flange Trial Balance Wizard

The Pinion Flange test wizard will run you through the various steps required to
complete your test. These will steps will cover:

Connections
Mounting the accelerometer and magnetic fixture
Entry of required technical data

4.4.2.1.1 Initial Run

Before you begin

Insure the vehicle is properly supported (refer to service information)
Remove rocks and debris from the tires
Ensure all the leads are clear of rotating components
Disable ABS and Traction control if equipped
Turn off the AC and other accessories

Find a suitable shaft speed.  Run the engine with the transmission in high gear to
highway speed (65-70 mph typical).  The software will capture the RPM when held
stable for more than 3 seconds or you can click the Edit Manually box and enter in the
desired shaft speed.

The balancing is ready to begin.  When ready press the green “Initial Run” button in
the software.  This step takes an initial measurement of the shaft.
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Accelerate to the required speed.  The RPM graph will be green when in the specified
RPM range.  Data will only be gathered while the RPM is in the specified range.  As
data is collected the % Completed bar will fill.  When complete, place the vehicle in
neutral and turn off the engine. 

4.4.2.1.2 Calibration Run 1

Place 4.5 grams of weight at location 1 by stacking 3 of the balancing weights (1.5 g
each).  Click the green Calibration Run 1 button to proceed.   Note that the weights
can be mounted to the front or rear of the flange.
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Accelerate to required speed until the % complete bar reaches 100%.  When complete,
place the vehicle in neutral and turn off the engine. 

4.4.2.1.3 Calibration Run 2

Remove the balancing weights from position 1 and install them at position 3.  Chick
the green Calibration Run 2 button to proceed.
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Accelerate to required speed until the % complete bar reaches 100%.  When complete,
place the vehicle in neutral and turn off the engine. 

4.4.2.1.4 Calibration Run 3

Remove the balancing weights from position 3 and move them to position 5.  Click on
the green Calibration Run 3 button to proceed.
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Accelerate to required speed until the % complete bar reaches 100%.  When complete,
place the vehicle in neutral and turn off the engine. 

4.4.2.1.5 Balance the shaft

Remove the balancing washers from position 5.  Install the balancing washers at the
location(s) directed by the software to balance the shaft.  Click the green Verification
button to continue.
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Accelerate to required speed until the % complete bar reaches 100%. When complete,
place the vehicle in neutral and turn off the engine. 

4.4.2.1.6 Verification run

The final imbalance will be displayed by the software.  If the imbalance exceeds the
minimum requirement the software will suggest removing the rear tires (ensure the
rotors or drums are secured to the hub) and restarting the test.

If restarting the test, remove all the balance weights.  The ”Initial Run” button can be
clicked to restart the test or the “Balancing” button can be clicked to go back through
the setup wizard.



Tests34

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved.pd.en r12

4.4.2.2 Hose Clamp Trial Balance Wizard

The Hose Clamp wizard will run you through the various steps required to complete
your test. These will steps will cover:

Connections
Mounting the accelerometer and magnetic fixture
Entry of required technical data

4.4.2.2.1 Initial Run

Before you begin

Insure the vehicle is properly supported (refer to service information)

Remove rocks and debris from the tires

Ensure all the leads are clear of rotating components

Disable ABS and Traction control if equipped

Turn off the AC and other accessories

Find a suitable shaft speed.  Run the engine with the transmission in high gear to
highway speed (65-70 mph typical).  The software will capture the RPM when held
stable for more than 3 seconds or you can click the Edit Manually box and enter in the
desired shaft speed.

Place the first clamp on the rear of the shaft.  Clearly mark its location – this is going
to be the reference point for all other measurements.  Label the mark as “0 mm”.

Measure the distance specified by the software to place the second clamp.  Place the
second clamp next to the first.

When ready press the green “Initial Run” button in the software.
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Accelerate to the required speed.  The RPM graph will be green when in the specified
RPM range.  Data will only be gathered while the RPM is in the specified range.  As
data is collected the % Completed bar will fill.

4.4.2.2.2 Calibration Run 1

Once the % Completed bar is filled the software will direct you to place both clamps at
the 0 mm mark and to click on the green Calibration button when ready.
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Accelerate to required speed
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4.4.2.2.3 Calibration Run 2

Measuring in the direction of forward shaft rotation, measure and mark the point
indicated by the software.  Place both clamps and press the green Calibration button
when ready.

Accelerate to required speed.
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4.4.2.2.4 Calibration Run 3

Measure the distance specified from the 0 mm mark and place both clamps.

Accelerate to required speed.
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4.4.2.2.5 Balance the shaft

Measure and mark the locations directed by the software and place the clamps.

Accelerate to required speed.
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4.4.2.2.6 Verification run

The final imbalance will be displayed by the software.  If the imbalance exceeds the
minimum requirement the software will suggest removing the rear tires (ensure the
rotors or drums are secured to the hub) and restarting the test.

If attaching a single weight is desired the hose clamps can be removed and replaced
with a single weight as indicated by the software at the location of the blue arrow.

4.4.3 Options
This menu is found under Tools in the main menu bar when the Propshaft Balancing
test is selected.

Choosing Options reveals the Propshaft Balancing Wizards selection screen.
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4.5 NVH
NVH (Noise, Vibration and Harshness) is the study of unwanted movements and
sounds generated by a vehicle. The PicoDiagnostics NVH software can analyze
vibrations and help to diagnose NVH problems. All you need is a PicoScope Automotive
oscilloscope and the PicoDiagnostics NVH kit.

4.5.1 Equipment
Microphone: a sound-sensing device connected to the PicoScope oscilloscope. It can
be used to pick up noise inside the vehicle cabin, or from outside the vehicle in cases
such as brake squeal.

PicoScope oscilloscope: receives signals from the microphone or accelerometer, or
other vehicle component, converts them to digital data and feeds this to the computer
for analysis.

Accelerometer: a vibration-sensing device connected to the PicoScope oscilloscope. It
must be attached rigidly to a vibrating part of the vehicle using the magnet or
mounting screw supplied.

NVH interface: allows microphones and accelerometers to be connected to the
PicoScope oscilloscope. The NVH interface supplies power to the amplifier while
transmitting vibration and sound signals to the oscilloscope.

4.5.2 Terminology
NVH is a specialist area of engineering that has its own terminology. Some of these
terms are from signal processing mathematics and might not be familiar to technicians
without NVH training.

Amplitude: the strength of a vibration or the loudness of a sound. On the graphs
produced by the PicoDiagnostics NVH software, higher peaks indicate larger
amplitudes.

Frequency: the speed at which a component rotates or vibrates. The most common
measures of frequency are RPM (revolutions per minute), CPM (cycles per minute) and
hertz (vibrations per second). A rotation rate of 60 times per minute (60 RPM) is equal
to one rotation per second or 1 hertz (abbreviated to 1 Hz). The graphs produced by
the PicoDiagnostics software show vibrations arranged by frequency. Lower
frequencies are always shown on the left, higher frequencies on the right.

Fundamental: see Harmonic.

Harmonic: when a component rotates or vibrates at a certain frequency, it can also
cause vibrations at higher frequencies—two, three or more times its own frequency.
The frequency of the original rotation or vibration is called the fundamental frequency,
and the faster frequencies are called harmonics. Twice the fundamental frequency is
called the second harmonic, three times is called the third harmonic, and so on.

Order: another word used to describe harmonics. A vibration at twice the speed of a
rotating component is called a second-order vibration; three times the speed is a
third-order vibration, and so on.

Resonance: a marked increase in the transfer of energy from one vibrating
component to another at a particular frequency. For example, if a body panel is normally
quiet but vibrates strongly at a particular engine RPM, resonance is the likely cause.
The body panel is said to 'resonate' at that RPM.
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Spectrum: a graph that shows sounds and vibrations. The horizontal position of the
vibration shows its frequency: lower frequencies are on the left, higher on the right.
The vertical position of the vibration shows its amplitude: higher amplitudes (stronger
vibrations) are at the top, lower at the bottom.

4.5.3 Connecting the PicoScope and sensor
a) Connect the oscilloscope to your computer
using the blue USB cable supplied with the
oscilloscope.

b) Plug your chosen sensor into the NVH Interface
Box.

Note: When using the  accelerometer observe the
handling instructions supplied with the
accelerometer and magnet.

c) Connect the NVH Interface box to Channel B on
the PicoScope oscilloscope.

Important: You must connect the NVH Interface to Channel B on the PicoScope
oscilloscope. Channel A is reserved for the RPM signal. Alternatively connect an OBD2
device between the vehicle and the test computer to detect the signal.

4.5.4 Running the PicoDiagnostics software
Click the PicoDiagnostics icon on your Windows desktop:

or run PicoDiagnostics from the Windows Start menu.

4.5.5 Selecting the NVH test
Click NVH:
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4.5.6 NVH Wizard
Once the NVH test has been selected you will be presented with the Setup tab and
NVH Wizard screen.

Within the Wizard there are four options:

Start a new test: This option guides you through the various steps in order to correctly
setup the NVH test parameters.

Load a saved test: This option opens the familiar Windows Open dialog box. Navigate
to your chosen file and choose Open to see your test data on the Record and Analyze
tab.

Skip the wizard process. Use the last settings I entered: This option takes you to the
final Wizard screen. Clicking Finish shows the Record and Analyze tab (no data), with
previously used settings applied.

Cancel: Canceling the NVH Wizard returns you to the Setup tab for NVH Manual setup.
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4.5.7 NVH Manual setup
If the NVH Wizard has been canceled but you wish to run an NVH test you can either
restart the Wizard by clicking the NVH button, or by choosing NVH from the Tests
menu. Alternatively you will be directed to the NVH test setup tab:

An RPM Signal source needs to be selected, choose either:

Square Wave / Tach

Static RPM

J2534 / ELM327 Scan Tool

Square Wave / Tach

For this option connect any signal proportional to RPM, such as camshaft, to Channel A
of the oscilloscope.

Static RPM

If the vehicle will remain at a static RPM during the test, enter the RPM value here.

J2534 / ELM327 Scan Tool

a) Plug the J2534 scan tool into a USB port on the computer.

b) Check that the program recognizes the scan tool.

c) Plug the J2534 scan tool into the vehicle’s 16-pin (OBD-II or EOBD) diagnostic
socket.
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d) Check that the RPM signal is being received:

The Vibration Signal settings also require confirmation:

Sensor Location indicates where the sensor will be placed. If the vibration can be felt
when sat in the vehicle, Passenger compartment would be selected. If the software
then identifies the problem vibration as originating from the engine, the accelerometer
can be moved into the engine bay, and this setting adjusted to Engine
compartment.

Sensor Type is set in order to identify the type of sensor attached to the NVH
interface.

Signal Options You can adjust the capture time to last from 50 to 500 seconds.

4.5.8 Signal quality check
The Vibration Signal on the Setup tab includes a Signal Quality bar. Here you are
able to check the software is registering the signal from the accelerometer. Tap the
accelerometer with your finger and check that a pulse is shown on the signal bar:

No vibration: Vibration detected:

4.5.9 Entering vehicle information

Select the Vehicle Information tab. If
possible select the vehicle's drivetrain
configuration, and enter the make, model
and year of manufacture.
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Select the Advanced button to enter
more specific vehicle details.

4.5.10 Testing the vehicle
To begin the test:

Click the Start button: 

The time chart at the bottom of the screen will show the signal from the
accelerometer. Start the engine. 

Note: If the vibration can be felt while the vehicle is stationary then the test can be
done in the workshop. Otherwise, a road test will be necessary.

Run the road test or workshop test while PicoDiagnostics captures data from the
vehicle. You will see data appearing in the time chart at the bottom of the window.
This chart also shows RPM, road speed and gear selection for the duration of the test.

When the test is finished, click the Stop button: 

To reset the current capture and clear any recorded data while retaining the test

settings, click the Reset Capture button: .
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4.5.11 Viewing the results
For the clearest results, select the region of the test where the vibration was at its
strongest. Do this by dragging the mouse over the time chart from the beginning to
the end of the region of interest.

You can now view the results in a number of ways. Click one of the view buttons to
choose a view:

4.5.11.1 Frequency graph

This basic display shows the spectrum of the signal from the sensor. In the example
below, the main vibration detected was at E2 (engine, second order). E2 on a four
cylinder engine is a normal vibration. There are two firing events each revolution
which are detected as twice the engine frequency. An excessive amount of E2 indicates
a problem with the engine or an engine mount.
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4.5.11.2 RPM order graph

This spectrum graph has the frequency scaled in multiples of RPM, so harmonics
appear at fixed positions regardless of engine RPM. In the example, there is a peak at
2.00 times the engine RPM. Again, this corresponds to the two firing events. This view
isolates engine speed related vibrations.
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4.5.11.3 Road speed graph

In this graph, frequencies are scaled to road speed, so wheel and axle-related
harmonics appear at fixed positions regardless of road speed. This makes it easier to
spot propshaft and wheel-related vibrations during a road test.
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4.5.11.4 Bar graph

This view lists all the selected vibration harmonics and shows their values in real time.
Unknown (U) vibration peaks are also shown.



PicoDiagnostics User's Guide 51

Copyright © 2009-2014 Pico Technology Ltd.  All rights reserved. pd.en r12

4.5.11.5 3D frequency graph

This creates a record of how the vibration spectrum changed over time during a test
drive. Selected vibrations are plotted as colored paths. The axes can be dragged to
change the vertical and horizontal scales and the viewing angle.

4.5.11.6 Graph features

General features
Drag left and right on the graph to position the order
markers. The markers are automatically positioned at
the fundamental frequency and its harmonics.

Drag the vertical axis up and down to change the vertical
scale.

Drag the colored box at the bottom of each frequency
ruler to move the ruler.

Right-click on any graph to reveal the context menu:

Auto Scale. This will enlarge or reduce the vertical scale
to make the signal fit on the graph.

Reset the scale. Resets the scale view to default.

Reference Waveforms. Available in Frequency view, use
this function to add previously saved data as a reference.

Clicking this accesses the Customer Details information
screen.
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Clicking this button will preview the report ready for
printing.

Click any vibration marker for more information.

Use this button to show or hide specific vibration orders
on each graph.

Vibration order markers
In the various frequency graphs, vibration orders are marked with labels such as “T1”
and “E2”. The letter indicates the type of vibration:    

• E = Engine
• T = Tires
• P = Propshaft
• U = Unknown
• AP = AC pump pulley
• A = Alternator pulley
• PS = Power steering pulley
• W = Water pump pulley

and the number is the order. For example, “E2” is the second-order engine-related
vibration.

Click on any marker in PicoDiagnostics for more information.

4.5.12 NVH Options
Location: Options on the menu bar

Note: some of the commands shown below might not be available unless the Enable
Advanced Options box is ticked in the Advanced Options dialog.

Save Settings: PicoDiagnostics will remember any changes you made to the
program settings and use them next time you run the program.

Advanced Options: Opens the Advanced Options dialog, which controls the signal
processing algorithms used by PicoDiagnostics.

Strobe Light: Triggers a strobe light at a specified frequency. The strobe light
must be connected to the computer's audio output.

Load Audio Files: Opens the Load Audio dialog for using a WAV format audio file
instead of using the microphone.
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4.5.13 NVH Advanced Options
Location: Options on menu bar, then Advanced Options

Enable Advanced Features: Some commands under the main Options menu are
hidden unless this box is ticked.

Enable Wizard: By default this option is enabled. To stop the NVH
Wizard from appearing, remove the tick from this box.

All other options: Do not adjust these unless recommended to do so by
your Technical Support department.
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4.5.14 Strobe Light dialog
Location: Options > Strobe Light command on the main menu

Controls a strobe light connected to the computer's audio output.

Strobe light control: links the strobe light to a specified vibration (transmission
fundamental, 2nd or 3rd harmonic; engine fundamental or 2nd harmonic; or Fixed).

Fixed Frequency: if the Strobe light control is set to Fixed Frequency, this control
sets the frequency of the strobe light.

Correction Factor: the factor by which the software multiplies the frequency of the
signal.
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4.5.15 Load Audio dialog
Location: Options > Load Audio Files on the menu bar

This dialog allows you to analyze previously recorded audio, for example of vehicle
noise recorded by a customer. The file must be in WAV format.

1. Click Load and locate the audio file.
2. Verify that the Sound Properties are correctly shown.
3. If desired, click Play to listen to the file.
4. To convert the file for vibration analysis in PicoDiagnostics, click Create Signal.
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